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KD2 Pro 11 KD2 PRO CE COMPLIANCE

11 KD2 Pro CE Compliance

Application of Council Directive: 2004/108/EC and 2011/65/EU

Standards to which conformity is EN 61326-1:2013 and

declared:
EN 50581:2012
Manufacturer Name: Decagon Devices, Inc.
2365 NE Hopkins CT
Pullman, WA 99163 USA
Type of Equipment: Thermal Properties Meter
Model Number: KD2 Pro
Year of First Manufacture: 2006

This is to certify that the KD2 Pro Thermal Properties Meter, man-
ufactured by Decagon Devices, Inc., a corporation based in Pullman,
WA, USA meets or exceeds the standards for CE compliance as per
the Council Directives noted above. All instruments are built at
the factory at Decagon and pertinent testing documentation is freely
available for verification.
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KD2 Pro 10 APPENDIX B

1 INTRODUCTION KD2 Pro
Table 1: Available Sensor Kits
SH-1 Sensor RK-1 Sensor | TR-1 Sensor | KS-1 Sensor
Kit Kit Kit Kit
SH-1 Dual RK-1 Single TR-1 Single KS-1 Single
Needle Sensor Needle Sensor | Needle Sensor | Needle Sensor
SH-1 RK-1 TR-1 Glycerin
Verification Verification Verification Verification
Standard Standard Standard Standard
Certificate of Certificate of Certificate of Certificate of
Quality Quality Quality Quality
Assurance Assurance Assurance Assurance
Arctic Arctic
Dual Needle Alumina Alumina, Replacement
Spacer Thermal Thermal Lid Septums
Grease Grease
SDS Arctic SDS Arctic | SDS Glycerin
Alumina Alumina
5/32 2.40 mm Drill
Roto-Hammer | Bits
Drill Bits
RK-1 Quick Concrete Pilot
Start Pins

Note: You can configure your KD2

of the sensors listed in Table 1.

1.3 Customer Support

Pro with one or a combination

If you ever need assistance with your device, have any questions or
feedback, there are several ways to contact us. Decagon has Cus-
tomer Service Representatives available to speak with you Monday
through Friday, between 7am and 5pm Pacific time.

Note: If you purchased your sensor through a distributor, please con-

10 Appendix B

10.1 Send Feedback to Decagon

The KD2 Pro Utility Software makes it easy to send feedback, bug
reports, and feature requests to Decagon or your Decagon Distrib-
utor. Choose “Send Feedback to Decagon...” from the Help menu.
This opens the window shown in Figure 10.

3 Send Feedback to Decagon

Mame (required) Campany Mame

User Marme User Camparny

Email Address Telephone (include area code)

use@example, com 5E5-555-1212

Type of feedback Please respond via

General Feedback A Emnail “

Please describe the feedback below

My software works great. ..

Send the following file (file size can be up to & MBE):

=

[(Jindude KD2 Pro Ukility error log Files

Send the feedback to my Decagon Representative's email address:

Figure 10: Send Feedback to Decagon
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1 INTRODUCTION KD2 Pro

lation, operation, use, misuse, nonuse, repair, or replacement of said
material and equipment, or out of the use of any method or process
for which the same may be employed. The use of this equipment con-
stitutes Buyer’s acceptance of the terms set forth in this warranty.
There are no understandings, representations, or warranties of any
kind, express, implied, statutory or otherwise (including, but with-
out limitation, the implied warranties of merchantability and fitness
for a particular purpose), not expressly set forth herein.

KD2 Pro 8 REFERENCE MATERIALS
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Please visit www.decagon.com/thermal for more information on ther-
mal properties in relation to density, water content, and temperature.
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2 KD2 PRO OVERVIEW KD2 Pro

Accuracy:
(Conductivity): Hmﬁ from 0.2 to 2 ?;5 +0.01 AS*S
from 0.02 to 0.2 Q:iﬁ
Cable length: 0.8 m
10 cm (large) single needle (TR-1)
Size: 2.4 mm diameter x 10 cm long
Range:
0.1 to 4.0 3;5 Agmibﬁ conductivity)
25 to 1000 °C' * §3# (thermal resistivity)
Accuracy:
AOosmcnaiS\v. +10% ASMH\NV
+0.02 s s
Cable length: 0.8 m
3 cm dual-needle (SH-1)
Size: 1.3 mm diameter x 3 cm long, 6 mm spacing
Range:
0.02 to 2.00 AS* 7 (thermal conductivity)
50 to 5,000 °C'* §7 (thermal resistivity)
0.1 to 1.0 = A%m:mz;%v
0.5 to 4.0 ASw 5 (volumetric specific heat)
Accuracy:
AOosmcnﬁiS\v + 10% 0 M\B
£ 0.01 AS*NV from 0.02 to 0.20 Q;*Nv
(Diffusivity) £10% at conductivities above 0.1 AS* )

A<oEEmﬁEn Specific Heat) +£10% at conductivities above

0.1 AS*MQ
Cable length: 0.8 m

KD2 Pro 7 KD2 PRO THEORY

sought which minimize the difference between model and measured
values of temperature rise. Temperature of the needle is measured,
so AT is first computed by subtracting the initial temperature from
all readings. Temperature rise is further scaled by multiplying by 47«
and dividing by ¢. If we call this new temperature variable T*, then
we find the values of k£ and D that minimize the sum of squares of

€error.
SSE = (T; — M) (10)

where the T} are the measured values and the M} are values modeled
with Equation 9. Equation 11 shows the standard error of estimate
for the measurements.

Sye =1/ —— (11)
where n is the number of measurements. The units of Sy, are mC/W.
It can be made dimensionless if it is multiplied by the thermal con-
ductivity, k. This dimensionless value gives the error in fitting the
model to data as a value independent of heater current or the ther-
mal conductivity of the medium. The KD2 Pro computes err as in
equation 12.

err = kSy, (12)

It is a dimensionless measure of the goodness of fit of the model to
the data. It can be converted to temperature by dividing by k& and
multiplying by gq.

Note: The Err term is not a rigorous statistical indicator of mea-
surement quality, but it serves as a qualitative quality indicator.
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2 KD2 PRO OVERVIEW

KD2 Pro

2.2 Keypad Operation

K DNW PRO

Figure 1: KD2 Pro KeyPad

KD2 Pro 7 KD2 PRO THEORY

Here, Fi is the exponential integral,” and b,, by and by are the con-
stants to be fit. T, is the temperature at the start of the measurement
and ¢ is the heat input. The first equation applies for the first ¢
seconds, while the heat is on. The second equation applies when
the heat is off. Compute thermal conductivity from Equation 4 and

diffusivity from 5.
1
k=— 4
™ (4)

72

@Hg (5)

You can find the conductivity and diffusivity by fitting equation 1
to the transformed data. The correct values of by, by and by are the
ones which minimize the sum of squares of error between the equa-
tions and the measurements. Use the Marquardt (1963) non-linear
least squares procedure to find the correct values. This procedure
is susceptible to getting stuck in local minima and failing to find a
global minimum in some problems (the single needle problem is a
perfect example of a bad non-linear least squares problem) but the
dual needle problem typically works well. The KD2 Pro can find the
three model parameters quickly.

7.2 Single Needle Algorithm

Heat is applied to a single needle for a time, t5, and temperature is
monitored in that needle during heating and for an additional time
equal to t; after heating. Two needle sizes are used; One (the KS-
1) is 1.2 mm diameter and 6 cm long. The other (the TR-1) is 2.4
mm diameter and 10 cm long. The temperature during heating is
computed from equation 6.

T =mg + mat +mgInt (6)

Where my is the ambient temperature during heating (which could
include some offset for contact resistance and the heating element
being adjacent to the temperature sensor inside the needle), ms is
the rate of background temperature drift, and mg is the slope of a
line relating temperature rise to logarithm of temperature.

 Abramowitz and Stegun, (1972).
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2 KD2 PRO OVERVIEW KD2 Pro

ment in liquid samples for more information). However, the small
size of the needle and typically short heating time make the KS-1
a poor choice for granular samples such as soil and powders where
contact resistance can be an important source of error. In insulating
materials, the errors from contact resistance become negligible mak-
ing the KS-1 sensor a good choice.

TR-1

The large (10 cm long, 2.4 mm diameter) single needle TR-1 sensor
measures thermal conductivity and thermal resistivity. We designed
the TR-1 primarily for soil, and other granular or porous materi-
als. You can either insert the pilot pin or drill an appropriate sized
hole for the TR-1 sensor. The relatively large diameter and typically
longer heating time of the TR~1 sensor minimize errors from contact
resistance in granular samples or solid samples with pilot holes. The
TR-1 needle heats the sample significantly more than the KS-1 sen-
sor, which allows it to measure higher thermal conductivity samples
(see earlier specifications). Customers should not measure low vis-
cosity liquid samples with the TR-1 sensor. The 2.4 mm diameter
of the TR-1 makes it more robust than the KS-1, meaning that it
is less likely to be damaged by normal usage conditions in soil or
other solid materials. Additionally, the dimensions of the TR~1 sen-
sor conform to the specifications for the Lab Probe called out by the
IEEE 442, “Guide for Soil Thermal Resistivity Measurements,” and
ASTM 5334, “Standard Test Method for Determination of Thermal
Conductivity of Soiled and Soft Rock by Thermal Needle Probe Pro-
cedure.”

Note: Despite its durability, the TR-1 is a hollow needle that bends
with enough applied force. Although the TR-1 comes with drill bits
for pilot holes, drilling straight holes in solid materials like rock and
concere is very difficult. Consider using the RK-1 for applications
imvolving solid rock and concrete.

SH-1

The dual needle SH-1 sensor measures volumetric heat capacity, ther-

10

KD2 Pro 7 KD2 PRO THEORY

7 KD2 Pro Theory

Researchers have used transient line heat source methods to measure
thermal conductivity of porous materials for over 50 years. Typically
a probe for this measurement consists of a needle with a heater and
temperature sensor inside. A current passes through the heater and
the system monitors the temperature of the sensor over time. Analy-
sis of the sensor temperature determines thermal conductivity. More
recently the heater and temperature sensors have been placed in sep-
arate needles. In the dual probe the analysis of the temperature vs
time relationship for the separated probes yields information on dif-
fusivity and heat capacity as well as conductivity.

An ideal sensor has very small diameter and a length perhaps 100
times its diameter. It would be in intimate contact with the sur-
rounding material and would measure the temperature of the mate-
rial during heating and cooling. Ideally, the temperature and com-
position of the material in question would not change during the
measurement.

Real sensors fall short of these ideals in several ways. A sensor small
enough to be ideal would be too fragile for most applications. Mea-
surements in outdoor environments involve changing temperatures;
the ambient temperature generally is not constant. Heating moist,
unsaturated soil causes water to move away from the heat source,
thus altering the water content in the region of measurement, and
the hole made for the probe often disturbs the material around it
causing a contact resistance between the sensor and the material.

It is a challenge to design a sensor that gives accurate measurements
under all conditions. If the sensor is too small it is fragile, and the
contact resistance can be high in dry, porous materials. Large sensors
require a long heating time, but the long heating time drives water
away from the sensor and can cause free convection in liquid samples,
thus altering the reading. A high heating rate makes temperature
changes easier to read and less susceptible to temperature drift er-
rors, but results in water movement out of the measuring region and
free convection in liquids. We recommend long heating times to min-

95
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2 KD2 PRO OVERVIEW KD2 Pro

RK-1

Note: The RK-1 is optional and not included with the standard KD2
Pro

The thick (6 cm long, 3.9 mm diameter) single needle RK-1 sensor
measures thermal conductivity and thermal resistivity. We designed
the RK-1 specifically for use in hard materials like rock or cured
concrete, where you must use a rotary hammer to drill a hole to ac-
commodate the sensor. The TR-1 sensor is generally more accurate
than the RK-1 sensor and is the preferred choice in granular and
solid materials as long as you can make a hole to accommodate the
longer and thinner sensor. In instances where the material is too
hard to drill a hole for the long, thin TR-1 sensor, a %m or 4 mm
rotary hammer bit (included in the RK-1 kit) can be used to drill
a pilot hole in the material. Make sure to remove any dust or drill
cuttings from the rotary hammer hole using a swab or compressed
air before inserting the RK-1 sensor. It is also necessary to use the
included thermal grease to ensure good thermal contact between the
RK-1 sensor and the test material.

Note: Do not use the RK-1 sensor in liquid samples.
Read Time

The read time is the time, in minutes, the KD2 Pro takes to gather
data for computing thermal properties. It applies heat to the sensor
for half of the set time, and takes measurements over the full time.
The KD2 Pro waits thirty seconds for temperature equilibration be-
fore heating starts, so the entire measurement time should be the
“Read Time” plus 30 seconds. The sensor takes sixty temperature
readings during the read time, so the number entered here also de-
termines the number of seconds between temperature readings. This
number displays in the upper right corner of the screen and is avail-
able with each data record after downloading. Default read times
are one minute for the KS-1 sensor, two minutes for the SH-1 sensor,
five minutes for the TR-1 sensor, and ten minutes for the (optional)
RK-1 Sensor.

12
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2. PROBLEM:
My USB-to-Serial adapter is not showing in the communication port
picker.

SOLUTION

Enable “Force find all Communication Ports” in Preferences by go-
ing to the Edit > Preferences, and then selecting the Communication
tab. Enable the check box at the bottom of the screen. Enabling
this option may find other serial ports that are not available for use
by the KD2 Pro Utility (for example, modems installed in your com-
puter).

3. PROBLEM:
Downloading data stops in the middle with an error message saying
the Utility lost connection with the KD2 Pro.

SOLUTION

A noisy serial connection can disrupt the connection between the
Utility and the KD2 Pro. If this error happens regularly, you can try
setting your baud rate lower or increasing the number of times you
send a command to the KD2 Pro. Choose the Communications tab
in Preferences to alter this setting.

6.6 Service Instructions

If your KD2 Pro should ever require servicing, call Decagon at 509-
332-5599. We ask you for your address, phone number, your KD2 Pro
serial number, and your current firmware version. For non-warranty
repairs, we also ask for a method of payment.

Before shipping your instrument to Decagon, please contact us to
obtain a Request Maintenance Authorization number (RMA). This
allows our repair staff to keep track of your KD2 Pro. Once you have
acquired an RMA, send your KD2 Pro to Decagon.

53
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2 KD2 PRO OVERVIEW KD2 Pro

2.4 KD2 Pro Sensor Compatibility

Table 2: Sensor Use Guide

7 Sample Material 7 KS-1 7 TR-1 7 SH-1 7 RK-1 7

Low viscosity Liquids
(Water)
High Viscosity Liquids

BEST! NO NO NO

BEST? OK? NO NO
(glycerol, oil)

Insulation and Insulating BESTS NO NO NO
Materials
Moist Soil NO BEST OK OK

Dry Soil, Powders, and

NO BEST* OK OK
Granual Materials

Concrete and Rock NO BEST>" | OK® | BEST”
Other Solids NO BEST® OK OK
Volumetric Specific Heat NO NO BEST NO
Thermal Diffusivity NO NO BEST NO

In low viscosity liquids, set the read time to the minimum allowed one minute
and only operate in low power mode to avoid free convection.

2In high viscosity liquids, only use the KS-1 or TR-1 in low power mode.

3The KS-1 in default mode (low power, 1 min read).

“In dry granular materials where contact resistance can be significant, extend
the read time to the maximum allowed ten minutes to produce the most accurate
results.

5In solid materials where a pilot hole has been drilled and contact resistance
can be significant, use thermal grease and extend the read time to the maximum
allowed ten minutes to produce the most accurate results.

5The SH-1 sensor takes accurate measurements in rock and cured concrete,
but it is very difficult to drill small diameter, parallel holes in these materials to
accommodate the SH-1 needles.

"The TR-1 is generally more accurate than the RK-1 sensor and should be
used if possible. However, it is extremely difficult (or impossible) to drill a long,
thin hole into cured concrete and rock samples to accommodate the TR-1. The
TR-1 also comes with pilot pins for use in wet concrete or fluidized backfill.

14
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mal environment (e.g. insulated chamber or cooler), and allow 15
minutes of equilibration time before taking the measurement. The
Delrin blocks have slightly different thermal conductivities from lot
to lot, so we record the correct values for K, C, and D for your
individual Delrin block are recorded on your Certificate of Quality
Assurance. Your readings should be within 10% of the values on the
certificate

Verification for the TR-1 and optional RK-1 is similar to that for
the SH-1. Place the needle in the block, wait fifteen minutes, taking
care to minimize temperature disturbances, and then take a reading.
The reading of the value recorded on your Certificate of Quality As-
surance be within 10%.

At the request of multiple KD2 Pro operators, we have character-
ized the temperature dependence of the thermal conductivity of the
TR-1 and RK-1 verification cylinders. We collected measurements
on three black plastic cylinders from different lots of material over
the temperature range of —20 to 60 °C (Figure 9). We found little
temperature dependence on any of the samples with maximum dif-
ferences over the —20 to 60 °C range. The difference is never greater
than 0.004 FN (~1%). Figure 9 shows a graphical representation of

m.
these values.

0.400
0.390 X\I’.w
0.380

0.370

Measured Thermal Conductivity
(W /mK)

=o=cylinder 1
0.360 H - H T T ==cylinder 2
m\m|I|- cylinder 3

0.350

0.340

-20 0 20 40 60 80
T
(deg C)

Figure 9: Thermal Conductivity as a Function of Temperature.
Error bars represent +1 standard deviation in five replicated
measurements.
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2 KD2 PRO OVERVIEW KD2 Pro

2.5 Installing the Sensors

We designed all four KD2 Pro sensors for ease of installation and
use. Please observe the following considerations when installing the
sensors.

e Insert the needle all the way into the material.

e We included a drill bit for the TR~1 sensor that you can use
to drill a pilot hole in material such as wood or hard soil. You
should use the optional RK-1 sensor for rock (or cured con-
crete). Drill a w\w: or 4 mm hole with a hammer drill and fill
it with thermal grease to provide optimal contact between the
RK-1 sensor and rock or concrete.

e For the dual-needle sensor, the needles must remain parallel
to each other during insertion to make an accurate reading.
Therefore, take care in tough material, which can splay the
prongs and adversely affect readings. Use the provided red tab
with pilot holes to make sure that the needles have the correct
spacing. Sample size depends on your sample material thermal
properties, contact Decagon for assistance in taking difficult
measurements.

e Because the sensors give off a heat pulse, you must allow a
minimum of 1.5 cm of material parallel to the sensor in all di-
rections, or errors occur.

Note: Bending the needles can damage the sensor beyond re-
pair. If the needle becomes bent, do not bend it back; contact
Decagon for a replacement.

e Good thermal contact between the sensors and the measured
medium is critical for accurate measurements if you drill a hole
for sensor insertion. Make sure that the sensor fits tightly into
the hole. Use the thermal grease included with your KD2 Pro
to improve contact in drilled holes or grainy samples.

16

KD2 Pro 6 MAINTENANCE AND TROUBLESHOOTING

6 Maintenance and Troubleshooting

Although Decagon built the KD2 Pro according to the highest quality
standards, you must practice proper care and maintenance to ensure
continuing operation.

6.1 Cleaning and Caring for the Sensors

The sensors are stainless steel, so they are easy to clean, though some
materials corrode stainless steel. Be sure to carefully clean the needle
after removal from sample materials. When they need cleaning, just
wipe them with a damp cloth. Take care never to bend or move
the needles. If the needle becomes bent, it is most likely broken
and requires testing and replacement. Contact Decagon to see if a
replacement sensor is necessary.

6.2 Changing the Batteries

Although we designed the KD2 Pro to provide an excellent battery
lifespan, the batteries eventually requires changing. When this hap-
pens, a low-battery indicator appears in the upper left hand corner
of the screen. The KD2 Pro requires four alkaline “AA” batteries.
Follow steps 1 through 4 to change the batteries.

1. Turn over the KD2 Pro and locate the battery cover.

2. Place your thumb on the grooves and pull away from the con-
troller to loosen the cover.

3. Remove the old batteries and insert new ones. Be sure to orient
the fresh batteries according to the polarity marks shown in the
case.

4. Update the time and date either in the Config menu of the
KD2 Pro, or by using the KD2 Pro Utility.
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3 THE MENUS KD2 Pro

3. Indicator for high power mode (HPM) or low power mode
(LPM).

The currently connected sensor name.
The measurement temperature in °C or °F.
Indicates the read time selected for current sensor.

Indicates that a reading is in progress.

® N otk

Progress bar that displays elapsed time.

The purpose of the Main menu is to take measurements. Section 5
provides more detailed information on how to take a measurement.
After taking a measurement, there are three measured values on the
left side of the screen.

Thermal Properties Reading - The calculated thermal measure-
ment and units reported.

Starting Temperature - The initial temperature prior to any
heating or cooling.

Err Value - The err value is the relative error for the reading. It
is a measure of how well the model fits the data (the Theory
section of this manual describes the model that is fit to the
data). If the model fits the data perfectly, then err = 0.0000.
The purpose of displaying this reading is to indicate possible
problems with the data. A good data set gives err values below
0.0100, except at very low thermal conductivity (e.g. insulation
materials). If the err value is unusually large, discard the data,
wait fifteen minutes and take another reading. Review section
7.3 for a detailed explanation of the err value.

On the right side of the screen are three save options:
Save - Save your reading as is;
Annotate - Attach a sample ID to your reading;
Discard - Cancel the current reading and return to the Main screen.

Note: If the data memory is full or the sample temperature is unsta-
ble during a reading, an error message displays at the bottom of the

18

KD2 Pro 5 TAKING MEASUREMENTS

5.5 Liquid Sample Temperature Control

Often it is desirable to control the temperature of the liquid sam-
ple above or below ambient temperature during thermal properties
measurement. It is important that the act of heating or cooling the
sample does not cause forced or free convection as mentioned above.
There are several things that should be avoided when measuring ther-
mal properties of heated or cooled samples. Cautions:

Do not heat the sample from the bottom (e.g. on a hot
plate). The temperature gradient from the heating causes
free convection.

Do not make measurements in a conventional refrigerator
or freezer. Conventional cooling devices have very large
cyclical temperature cycles which can cause excessive sam-
ple temperature drift and poor measurements. Vibrations
from the compressor also causes forced convection in the
sample.

Do not measure the thermal properties of the sample while
it is in a circulating water bath. The vibrations from the wa-
ter bath pump and from the circulating water causes forced
convection in the sample.

Controlling Temperature

Several researchers who use the KD2 Pro with liquid samples sug-
gest the following three steps as the best method for controlling the
temperature of liquid samples.

1. Heat or cool the sample (with sensor inserted) in a water bath.

2. Once the sample temperature has equilibrated to the desired
water bath temperature, turn the water bath off.

3. Allow enough time for the water bath to become absolutely
still, and make the measurement.

Note: FExperimental results from researchers have shown that the
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3 THE MENUS KD2 Pro

__NEOATAIETEEETE
iew

Download
Erraze

Recardad 12 of 4095

View

The View option allows you to view all data currently stored on
your KD2 Pro. Press Enter to access the readings, and use the ar-
row keys to scroll through them. By pressing Enter a second time,
you can see more detail about a reading.

Download

The Download feature sends the data saved in the KD2 Pro to your
computer. You have two download options:

Download All - This downloads the temperature readings as well as
the measured thermal properties.

Download Summary - This downloads just the measured thermal
properties.

Note: Your KD2 Pro comes with a USB-to-Serial cable for interfac-
ing with Microsoft Windows. The Utility makes downloading data to
your computer very easy.

If you are unable to use the KD2 Pro Utility, you can use the terminal
software to transfer the data from your KD2 Pro to your computer.
The following steps should apply to most terminal software programs.

1. Configure your terminal software with the following settings.

e 9600 baud

20

KD2 Pro 5 TAKING MEASUREMENTS

5.3 Measurements in Insulation

KS-1 Insulation measurements are best taken using a ten minute read
time. The long read time minimizes contact resistance errors, and the
low heat of the KS-1 needle reduces free convection errors. Always
drill a hole in foam insulation for the sensor. Manually pushing in the
needle can cause the insulation to bunch in front of and around the
needle resulting in a poor fit and a consequently a faulty reading. In
fiber type insulation materials, assure that the insulating materials
are not unduly disturbed by the needle insertion. (i.e. pushed in
front of the needle tip). Do not allow the sensor to move during the
measurement.

5.4 Measurements in Liquids

We designed the KS-1 sensor to measure thermal conductivity and
resistivity of liquid samples. However, measuring thermal properties
of liquids is difficult and great care must be taken to obtain accu-
rate and repeatable results. For an accurate measurement of thermal
properties of a liquid sample, the sample must be absolutely still in
relation to the KS-1 sensor. Convection, or bulk movement of the
sample, causes errors in the thermal properties measurement. FEr-
ror from convective heat exchange is often very large, rendering the
thermal properties measurement useless.

Note: We did not design the TR-1 and SH-1 sensors for thermal
properties measurement in liquids. They do not return accurate re-
sults in those materials.

Convective heat exchange in fluids can be broken down into two cat-
egories: forced and free convection. Forced convection occurs when
the fluid is agitated or mixed by mechanical forces. Free convection
may occur when a body of higher or lower temperature is present in
a fluid. The temperature difference between the body and fluid cre-
ates density gradients in the fluid, and these density gradients cause
the fluid to mix. From a practical standpoint certain steps can be
taken to minimize both forced and free convective heat exchange.
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3 THE MENUS KD2 Pro

CONFIG

Time: 1.3:93

Units: 51

Fead Time q6,
Fower Mode =

CONFIG

Date

Follow steps 1 through 5 to change the current date.
1. Press Enter to select the date display.

2. The date appears in the center of the screen in day/month /year
format. A pair of arrows are present above and below the first
number.

3. Use the up and down arrow keys to change this number.

4. Press Enter to move to the next item, and repeat step #3. If
you need to return to the previous number, press Escape.

5. When you have finished changing the last number, press Enter
to return to the Configuration Menu.

Time

22

KD2 Pro 5 TAKING MEASUREMENTS

taking measurements.

(b) Allow around 15 minutes between readings for tempera-
tures to equilibrate.

(c¢) If measurements are made in a temperature chamber or
water bath, make sure the sample temperature stays rela-
tively constant before the measurement starts. Measure-
ments made while a sample taken from an oven and cool-
ing to room temperature can show significant errors if the
cool rate is too fast. Measurements made while the sampe
is undergoing heating or cooling return large errors and
are less accurate than samples with a stable temperature

(d) When measuring thermal properties in the field, allow fif-
teen minutes or so after sensor insertion for temperature
equilibration.

. Minimize contact resistance. In granular materials, or in solids

where a hole has been drilled to accommodate the sensor, there
is an additional thermal resistance between the heated sensor
and the material into which the sensor is inserted. This ex-
tra resistance is called contact resistance, and it decreases the
thermal conductivity value registered by the sensor. This ef-
fect can be minimized by applying thermal grease to the sensor
prior to inserting it as described in the Decagon Application
Note “Reducing Contact Resistance Errors in KD2 Thermal
Properties Measurements” located in the Support section of
https://www.decagon.com/thermal. When you drill a hole for
the sensor, make sure the sensor fits in the hole is as tight as
possible. Inject thermal grease onto the needle as needed to
improve contact.

Long read times also decrease the effect of contact resistance.
If you are measuring a sample that might give errors from con-
tact resistance, increase the read time from the default to the
maximum (10 minutes) for most accurate results.

Finally, the TR-1 works best for dry granular materials and
powders that have large contact resistance, try to always use
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3 THE MENUS KD2 Pro

CONFIG

Single: 1 min(defaultIll™
._._”“ 1 _..m_q._m_m smin(default)
SH-1,0ual:  Z2min(default]
Rk-1.Rock: 10min(default]

Power Mode

Allows you to change the power mode each sensor type uses. Do
not change the power mode from the default settings unless you are
an expert operator and are making a specialized measurement. To
change the power mode, select the sensor and press enter to toggle
between high and low power mode. Press Esc or Menu to accept the
changes and exit the Power Mode menu. For more information on
situations where you might want to change from the default power
mode, see the Power Mode portion of Section 2.4.

g

Single: Lowi(defaultIg™
._._”“ 1 _..m_q._m_m High (detault)
SH-1,.0ual:  High(default)
RE-1.Rock: Highldefault)

Contrast

Allows you to change the screen contrast level. Press Enter and
follow the on-screen instructions to modify the contrast.
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5 Taking Measurements

Making thermal measurements with the KD2 Pro. Section 5 helps
you get accurate measurements.

Note: If the temperature of the sample is different from the tem-
perature of the needle, the needle must equilibrate to the surrounding
temperature before beginning a reading.

1. Attach appropriate sensor then turn on the KD2 Pro.

2. Properly insert the needle into the material to be measured.
(See “Installing the sensors” in this section for instructions.)

3. When the KD2 Pro turns on, you should be in the Main menu.
(Figure 2) If not, press the Menu key until you arrive there.
Press Enter to begin the measurement.

4. An icon appears on the left and right side of the screen. The
icon at left indicates the type of sensor connected. The cir-
cular icon indicates that a reading is in process. It changes
to a thermometer icon to indicate whether the measurement is
currently in heating or cooling mode; when the thermometer
is rising, heat is applied to the needle, and when it is falling,
heat is off. A progress bar at the bottom of the screen shows
the elapsed time.

5. When the reading is complete, the results display as follows.

(T3] DA TA T CONF TG TALITO
01222 @ Save

3.0°C < Annotate

err = 00016 O Discard
Beacard 2 of 4095

41



qc ov

‘sburpaL Pas0gs oY) 25042 nofi 1]
-un waYyy 2avs ouuvd nofi nq ‘sbuipvas oyv7 11198 fivw nofi ‘(sburpva.s

G60°7) 1 w099 4209 filowdws DIVDP 04 F(IM Y} PINOYS ION

‘uorpdo SIy) J09[9S NOA se
UO0O0S Sk SUI3oq pue ‘MULUL UIRTA 9} WOIJ SHTUN POYIos A[JUOLIND oY)
Ul ‘[eAI9JUI PO31I9[AS oY) Je 3urpeal 9y} soye) ol g3 oYL, "Sonurul
GT JO S[RAIOJUI Ul OWII} JUSTIOINSBOWL B 109[0S UeD NOK “A[[edIjRUOINe
sgurpear oxe) 03 01J g(I3 °Y2 dn 30s 01 NOA SMO[[e 9pOJN 0Ny oY T,

qeL 9POIN OMY 9L V'€

- ‘we)sAs guryerodo o1g g
H__n_H MM_H__.....m__”_ _L_U_m_m.Um__”_ 9} Ul OWI} PUR RBIRP JUOIIND PUR ‘SHUOUIAINSEIUl PaIo)s A[JUOLIND

JO Iaquunu 9y} ‘snje)s AI19)9e( ‘SNIvIS PUR UOISIOA SIRMULIY ‘ITOUINU

_”_ ._”_”_ N i _m_ _”_ _”_ N _..M“_ u_. _n_ _m_ _ 4 _u_ _n_ 0 H_ [RLISS S)T SUIPN[OUL ‘OIJ (I3 INoA jnoqe ojur [nyesn sAerdsip sy,

S L= T
_m_m"ﬂ ._“.u_...."._ “_m._t_m_m U90I0G UOTYRULIOJU] 01 (M :8 o3I

ELIE 5] EEn

'0Id (M INOA JO UOISIOA SIRMULIY PUR ISqUINU [RLISS o) sAerdsi(]

moqy COLELLA00g unp 2| -aun | faje] oid £

[N 2 L] suawainseaw 9o SjuaWaINseap palols
=0, d1aneq

.ﬁ* POOE SIERUIL JEMEYS SISMULTY

GL'| dY TUOIEIa A SIEMWIL

|ena] jE0Aues 2yy sbupys o)
S0AAD N0 FYT J #4125

b
SQIdNO0 uonewoju| oid Zao 3

SONHIN HHL € old cdM old ¢cd3l ALI'TILN Odd ¢d¥M HHL ¥

NE2 L dH “1aqunpy [euag




3 THE MENUS KD2 Pro

AUTOLL-— 6

N//_“_ 0222 Tntepual: 00:158 — 7

3__ 1! _.1=_ 24q. m+_n Count: 10 W/ 8
4 \\ arr = 0.0016 9

10

Reading Return Screen Shot Labels

1.
2.

w

NS oo

10.

Note:

Final measurement displayed in the selected units.
Icon showing connected sensor type.

Indicator for high power mode (HPM) or low power mode
(LPM).

Currently connected sensor type.
Measurement, temperature in °C or °F.
Indicates the selected read time.

Set the Measurement intervalusing the up and down arrows
when an hour glass is on the screen.

Hourglass icon indicating that time is elapsing until the next
measurement.

Number of readings taken.

The err value of your data (see description of err value in the
“Main menu” portion of this section for more details).

The KD2 Pro Utility gives you more options to control how

Auto Mode operates, including different time intervals, delayed start
times, and others.
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Number of Measurements: This is the total number of
measurements that you want the KD2 Pro to make while in
Auto Mode. The number is between one and the amount of
available memory. As you change this value, the Experiment
Duration value changes. The KD2 pro stores up to 4,095 read-
ings.

Experiment Duration: This is the total amount of time that
your KD2 Pro operates in Auto Mode, according to your mea-
surement interval and number of measurements selected. This
gives you an idea of how long the total Auto Mode experiment
time takes.

Available Memory: This shows how much memory you have
available for storing measurements. The KD2 Pro Utility pre-
vents you from defining an experiment that could exceed the
amount of available memory. If you reach the limit of mem-
ory storage, the KD2 Pro stops taking measurements in Auto
Mode.

KD2 Pro Date/Time: This shows the current time in your
KD2 Pro. If the time is not correct, click the Cancel button,
then choose “Set KD2 Pro Date/Time...” from the Actions
Menu.

. Click on the Start button. The KD2 Pro Utility then sends

your settings to the KD2 Pro.

. Unplug the cable from the KD2 Pro, then connect the desired

thermal properties sensor to the instrument. Your KD2 Pro
is now ready to make autonomous measurements as you have
programmed it.

Viewing KD2 Pro Information

Choose “View KD2 Pro Information...” from the Actions Menu to
see information about your KD2 Pro.
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4 THE KD2 PRO UTILITY KD2 Pro

e One available USB or serial port port (most models of USB-
to-serial adapters supported)

e Microsoft Excel 97 or better (for saving data as .xls files)

4.2 Installation

You can install the KD2 Pro Utility using the included USB drive
(found in the inside cover of the KD2 Pro Operator’s Manual). You
may also download and install the latest version of the Utility in the
Support section of the online KD2 Product page at www.decagon.com
/thermal.

The KD2 Pro Utility features four main menus, the File, Edit, Ac-
tions, and Help menus. These allow you to change program settings,
as well as settings on the KD2 Pro.

4.3 KD2 Pro Utility Menus
File Menu

Download Summary Data: Using this menu option or the down-
load button on the Main screen allows the user to download all data
except heating and cooling cycle temperature readings.

Download All Data: This allows for the download of all data,
including heating and cooling cycle temperature data stored on the
KD2 Pro.

Downloading Data:

This copies all saved measurement data on the KD2 Pro to your
computer. Follow steps 1 through 5 to download all measurements
on the KD2 Pro to your computer.

1. Make sure the USB-to-Serial cable connects to the KD2 Pro
and to a USB port on your computer.

2. Open the KD2 Pro Utility.

28
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Note: If you encounter an error message, please refer to the
Troubleshooting section for instructions.

4. A progress bar shows the status of the erase process.

4.6 Setting the Date and Time

You can set the KD2 Pro date and time by selecting “Set KD2 Pro
Date/Time...” from the Actions Menu. This automatically syncs the
KD2 Pro date and time to your computer time.

4.7 Setting the Auto Mode

The Auto mode of the KD2 Pro allows you to perform automatic
and autonomous measurements at specified time intervals. The KD2
Pro has pre-set measurement intervals to select for this mode, but
you can better customize how the KD2 Pro operates in Auto mode
using the KD2 Pro Utility software. For example, you can select
specific measurement intervals, delayed start times, and the number
of measurements from this menu.

Follow steps 1 through 3 to configure Auto Mode with the KD2
Pro Utility.

1. If the correct port is not automatically chosen, select the appro-
priate serial communication (COM) port from the “Use com-
puter communication port” control on the Main screen.

2. Choose “Configure Auto Mode...” from the Actions Menu. The
Configure Auto Mode screen appears.
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4 THE KD2 PRO UTILITY KD2 Pro

KD2 Pro Utility
File Edit Actions Help

KD2 Pro Utility
Usze the KD2 Pro Utility to:

* Download measurement data to your computer.
*Erase data stored in the KD2Z Pro.

*Set the date and time.

*Configure Auto Measure mode.

*Retrieve status information.

|Jze computer communication port;

Statuz: Downloading data from vour KDZ2 Pro

Cancel

Figure 3: KD2 Pro Downloading Data

Note: You can cancel a download in progress using the cancel button.
If you cancel, it does not save any downloaded data.

Erase Data Removes all data from the KD2 Pro. This is an ir-
reversable function.

Edit Menu

The Edit menu contains the cut, copy, paste, preferences, and select
all features. The important feature here is the Preferences window.
The Preferences window allows you to modify program and commu-
nication settings for the KD2 Pro. The Preferences window has three
tabs: the Data File, Communications, and Application tabs.

30
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4.4 Organizing Saved Data

Measurement Data from the KD2 Pro saves in the same basic struc-
ture regardless of the file format chosen. You can choose to download
summary data or all measurement data. A description of each type
of download follows.

Clicking the Download button or choosing “Download Summary
Data” from the File menu creates a file with the following columns:
e Measurement Time - Shows date and time of the reading.

e Sensor - The model number of the sensor used for this reading.

e K (Thermal Conductivity) - as AS«\MS or SQ;WMW 7
¢ p (Thermal Resistivity) - as °C' x G or %.

e °C (Specific Heat) - as ASN,%*.WV or ?memwv.

e D (Thermal Diffusivity) - as Sw@w or ﬁ‘m (dual-needle sensors
only).

Note: Columns for Specific Heat and Thermal Diffusivity are
only included when the downloaded data contains measurements
made with SH-1.

e Err- Quality of fit of the data to the KD2 Pro theoretical model.
e Temp(0) - Initial temperature of the sample as °C or °F.
e Sample ID - If saved with the measurement.

e Read Time - as minutes from the start of heating. The interval
between readings is also Read Time (in sec).

e Power Mode - Power mode selected during measurement.

Choosing “Download All Data” from the File menu creates a file with
all the data included in the summary file (listed above) and adds the
following columns:
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4 THE KD2 PRO UTILITY KD2 Pro

loaded data files. You can select to use “Windows Regional and
Language Options,” 24-hour time, or 12-hour time.

Communications Tab

P A

KD2 Pro Utility Preferences (23]

| Data File | Communications .pu_u_._nk_._u:”

3

Only change these settings if you are having trouble
communicating reliably with your KD2 Pro.

Command Retries \w (default) A

Mawimum Baud Rate ,._._mm_”__u:n_m*m:: -

Enable Force Find all Comm Ports if your USE to serial
adapter doesn't appear in the comm port picker. Please
note, enabling this option may alsa find comm ports that
are unavailable for use by this utility.

| Force Find all Communication Ports

Close

Figure 5: Preferences Menu — Communications Tab

Command Retries: If you encounter difficulty communicating
with your KD2 Pro, you can set the number of times the computer
should automatically try sending communications commands again
(up to ten times).

Maximum Baud Rate: You can set the maximum baud rate for
talking to your KD2 Pro. Choose a lower baud rate if you are not
getting reliable communications from your device.

Force Find all Communications Ports: This detects all COM
ports on your computer, and should be used if your USB-to-Serial
adapter does not appear in the “Use computer communication port”

KD2 Pro 4 THE KD2 PRO UTILITY
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control.

Application Tab

KD2 Pro Utility Preferences ==

Data File _ _uo.._.__..._::..na:._uzu_ Pﬂn_mzoj
Autornatic Intermet Version Check

7 Check far updates ta this Utility software and
" instrument firmware as program starts.

Automatic Clock Synchronization

V| Keep instrument's clock synchronized ta PC,

Close

Figure 6: Preferences Menu — Application Tab

Automatic Internet Version Checks: If you select this option,
the KD2 Pro Utility automaticallys check for a newer version using
Decagon’s Internet version check engine. It notifies you when a newer
version is available when your computer is connected to the Internet.
You can turn off the automatic check by unchecking this option. You
can manually check for updates anytime using the “Check for Utility
Updates...” option in the Help menu.

Automatic Clock Synchronization: Automatically sets the KD2
Pro time to your computer time, when you are connected to it. (See
instructions for setting this manually later in section 4.)
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